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3 ÚVOD 

POKYNY KE STUDIU 

MKP v Nastranu a Patranu 

Pro problematiky numerického modelování metodou konečných prvků v software 
Nastran a Patran jste obdrželi studijní balík obsahující: 

• integrované skriptum pro distanční studium obsahující pokyny ke studiu. 

Prerekvizity 

Pro studium tohoto předmětu se předpokládá absolvování předmětu Pružnost a 
pevnost I. 

Cílem učební opory 

Cílem je seznámení se se základními pojmy výpočtového modelování pomocí metody 
konečných prvků. Po prostudování modulu by měl student být schopen samostatně vytvořit 
model součásti se zadané technické dokumentace vhodný pro analýzu metodou konečných 
prvků. Stanovit a zadat vhodné okrajové podmínky modelu. Realizovat statickou MKP 
analýzu a vyhodnotit získané napěťově deformační chování výpočtového modelu.  

Pro koho je předmět ur čen 

Modul je zařazen do bakalářského studia oboru Aplikovaná mechanika studijního 
programu Strojní inženýrství, ale může jej studovat i zájemce z kteréhokoliv jiného oboru, 
pokud splňuje požadované prerekvizity. 

Skriptum se dělí na části, kapitoly, které odpovídají logickému dělení studované látky, 
ale nejsou stejně obsáhlé. Předpokládaná doba ke studiu kapitoly se může výrazně lišit, proto 
jsou velké kapitoly dále děleny na číslované podkapitoly a těm odpovídá níže popsaná 
struktura. 
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Při studiu každé kapitoly doporučujeme následující postup: 

 
Čas ke studiu: xx hodin 

Na úvod kapitoly je uveden čas potřebný k prostudování látky. Čas je orientační  
a může vám sloužit jako hrubé vodítko pro rozvržení studia celého předmětu či kapitoly. 
Někomu se čas může zdát příliš dlouhý, někomu naopak. Jsou studenti, kteří se s touto 
problematikou ještě nikdy nesetkali a naopak takoví, kteří již v tomto oboru mají bohaté 
zkušenosti. 

 
Cíl: Po prostudování tohoto odstavce budete umět 

  Popsat … 

 Definovat … 

 Vyřešit … 

Ihned potom jsou uvedeny cíle, kterých máte dosáhnout po prostudování této kapitoly 
– konkrétní dovednosti, znalosti. 

 
Výklad 

Následuje vlastní výklad studované látky, zavedení nových pojmů, jejich vysvětlení, 
vše doprovázeno obrázky, tabulkami, řešenými příklady, odkazy na animace. 

 
Shrnutí pojmů 

Na závěr kapitoly jsou zopakovány hlavní pojmy, které si v ní máte osvojit. Pokud 
některému z nich ještě nerozumíte, vraťte se k nim ještě jednou. 

 
Otázky 

Pro ověření, že jste dobře a úplně látku kapitoly zvládli, máte k dispozici několik 
teoretických otázek. 

 
Úlohy k řešení 

Protože většina teoretických pojmů tohoto předmětu má bezprostřední význam 
a využití v praxi, jsou Vám nakonec předkládány i praktické úlohy k řešení. V nich je hlavním 
významem aplikovat čerstvě nabyté znalosti získané z předmětu pro řešení reálných situací. 

 
Klí č k řešení 

Výsledky zadaných příkladů i teoretických otázek jsou uvedeny v závěru učebnice 
v Klíči k řešení. Používejte je až po vlastním vyřešení úloh, jen tak si samokontrolou ověříte, 
že jste obsah kapitoly skutečně úplně zvládli.  
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Úspěšné a příjemné studium s tímto učebním textem Vám přeje autor. 

Martin Fusek 
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1 ÚVOD 

V tomto textu bude vysvětlena základní práce s programy Patran a Nastran od firmy 
MSC Software. MSC.Software (dříve MacNeal-Schwendler Corporation) je největší světový 
dodavatel systémů v oblasti řešení počítačové podpory inženýrských návrhů. V portfoliu 
firmy jsou i další modelovací a výpočetní systémy, jmenujme např. software Marc, Adams, 
Actran, SimXpet, XFlow, a další.  Bližší informace o firmě naleznete na internetových 
stránkách http://www.mscsoftware.com, popř. na stránkách české pobočky 
http://www.mscsoftware.cz.  

Informace poskytnuté v tomto výukovém textu se zabývají pouze základy práce  
s produkty Patran a Nastran.  

Program Patran je pre/post-procesní software určený na tvorbu konečnoprvkových 
modelů a získání výsledků řešení. Umožňuje vytváření geometrie, zadávání materiálových 
vlastností, tvorbu okrajových či počátečních podmínek, nastavení vlastní analýzy. Velká 
podpora je kladena na import a editaci již hotových geometrických modelů z konstrukčních 
CAD systému. Poskytuje také velké množství funkcí na úpravu takto naimportovaných 
modelů. Patran spolupracuje s velkým množstvím konečnoprvkových řešičů, jmenujme např. 
Nastran, Marc, Abaqus, LS-Dyna, Ansys, a další. V oblasti postprocesingu zde existují velké 
možnosti: jednak vykreslení získaných výsledků (mapy průběhů vypočtených veličin, grafy, 
aj.), jednak je možno získané výsledky zobrazovat v testové podobě popřípadě je možno tyto 
výsledky uložit do externího souboru pro další zpracování.  

Produkt Nastran je světově nejpoužívanější konečnoprvkový program. První kód  
s tímto názvem je spjat s dobýváním kosmu a s Národním úřadem pro letectví a kosmonautiku 
(NASA). V současné době existuje několik klonů Nastranu (např. NEi Nastran, NX Nastran, 
OCF Nastran, aj.) a produkt od firmy MSC Software je jedním z nich. Oblast výpočtů,  
ve kterých je možno použít Nastran je široká – napěťová analýza, dynamika, vibrace, řešení 
komplexních systému, lineární a nelineární analýzy, optimalizace, aj. Produkt se, v současné 
době, hlavně zaměřuje na simulování multidisciplinárních problémů. 

V následujícím textu jsou zmíněny základní informace. U software Nastran jsou 
zmíněny informace týkající se základní práce se vstupním souborem řešiče, tedy struktura 
vstupního souboru, jaké typy elementů je možno v daném programu využít, jak vypadají 
výstupní soubory provedené analýzy. Protože rozsah textu je omezen, jsou zde probírány 
informace, které se váží k lineární statické analýze pružných těles. U modelovacího systému 
Patran budou zmíněny základní postupy nutné pro tvorbu konečnoprvkového modelu, tedy 
fáze přípravy. Další informace se týkají nastavení řešiče, v našem případě programu Nastran, 
a jeho spuštění. Nejsou ani opomenuty postupy pro získání a zobrazení výsledků již proběhlé 
analýzy. 
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2 MODELOVÁNÍ 

 
Čas ke studiu: 1 hodina 

 

 
Cíl: Po prostudování tohoto odstavce budete umět 

  Definovat co je to model ve vztahu k modelování inženýrských procesů. 

 Definovat jednotlivé typy modelů. 

 Znát problematiku chyb při modelování. 

 

 
Výklad 

 

Při řešení problémů se může postupovat dvěma odlišnými přístupy a to přímým 
řešením problému a nepřímým řešením. Při přímém řešení se formulovaný problém řeší 
zvoleným postupem - odhad, intuice, cit, zkušenost - a ten buď vede, nebo nevede k cíli, tedy 
k řešení. Nedovede-li daný postup k cíli, začne se řešit jinou metodou. Jedná se vlastně  
o metodu pokus-omyl. Nepřímé řešení je takové, že místo formulovaného problému se řeší 
jiný, který je snadněji zvládnutelný. Prostřednictvím jeho řešení se získá řešení primárně 
formulovaného problému. Je to řešení „oklikou“ - tj. řešení, při němž řešitel využívá svých 
schopností přemýšlet, hodnotit, posuzovat a srovnávat různé varianty a především jednat 
účelově, snažit se dosáhnou cíle s minimálním úsilím. Hovoříme o modelování. 

Modelování neboli simulace představuje experimentální proces, při němž se 
zkoumanému objektu (originálu, modelovému systému) jednoznačně dle určitých kritérií 
přiřazuje model. Model může být: fyzický, abstraktní nebo kombinovaný. 

Fyzický model - umožňuje provádět experimenty s modelem a zkoumat tak vlastnosti 
originálu (na modelu) pomocí dějů stejné fyzikální podstaty. Příkladem může být zkoumání 
obtékání vzduchu kolem modelu auta, letadla, aj. v aerodynamickém tunelu. 

Abstraktní model - je výsledkem některé obecné vědy. Tento model již neumožňuje 
provádět experimenty stejné fyzikální podstaty. Umožňuje zkoumat jevy probíhající  
na originále pomocí matematického popisu jejich průběhů. 

Kombinovaný model - je takový, kdy část modelu je fyzická a část abstraktní. 

V tomto textu se zaměříme pouze na modely abstraktní a to pouze na jednu skupinu a 
to modely výpočtové. 

Postup při vytváření a řešení výpočtového modelu se dá obecně shrnout  
do následujících kroků: 

1. Zadání úlohy. 
2. Rozbor zadání a smysl úlohy. 
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3. Výběr teorie, která bude použita při řešení úlohy (pruty, skořepiny, rovinná napjatost, 
atd.). 

4. Volba metody řešení (analyticky, numericky). 
5. Sestavení úplného souboru vstupních dat (geometrie, materiál, zatížení, aj.). 
6. Sestavení výpočtového modelu (zjednodušení, co zahrnout a co vypustit). 
7. Vlastní řešení. 
8. Zpracování výsledků a jejich interpretace. 
9. Rozhodnutí o dalším postupu (konec, nebo pokračování a úprava modelu). 

Proto, aby úloha mohla být vyřešena správně, musí mít řešitel potřebné znalosti, 
získané jednak ve škole, jednak praxí či samostudiem. Pro řešení vlastní úlohy musí mít  
k dispozici výpočetní prostředek, což je v současnosti nejčastěji počítač s vhodným 
hardwarovým a softwarovým vybavením. Asi nejdůležitější vlastnostmi při tvorbě 
výpočetních modelů jsou v první řadě tvůrčí schopnosti, zkušenost, cit a intuice. 

2.1 Chyby při modelování 

Při vytváření a vlastním řešení daného výpočtového modelu mohou a také vznikají 
chyby. Chyba je realita, se kterou se musí počítat. Nejzávažnější chyba je chyba kvalitativní , 
kdy daný model neobsahuje všechny důležité vlastnosti podstatné z hlediska řešení daného 
problému. Takováto chyba je nejzávažnější, protože je těžko odhalitelná a může vést  
ke katastrofickým problémům. Model se chová správně, ale neřeší námi hledaný problém. 
Opakem předchozí chyby je chyba složitosti, kdy model obsahuje kromě podstatných 
vlastností i vlastnosti nepodstatné. V lepším případě se prodlouží doba řešení problému,  
v horším případě se nemusí získat řešení úlohy vůbec. Dalším typem chyby je chyba 
kvantitativní , kdy model obsahuje všechny podstatné vlastnosti z hlediska řešení problému, 
ale jejich kvantitativní vyjádření je pro řešení problému nedostatečné. Častá chyba, která se 
vyskytuje při realizaci řešení, je chyba konkretizační. Model je sice vytvořen správně, 
obsahuje všechny podstatné vlastnosti, ale při jeho řešení vznikne chyba, např. chybné zadání 
vstupních údajů, chyba v nevhodné volbě použitého programu, aj. Tento typ chyb je snadno 
odhalitelný kontrolou získaných výsledků. Kromě toho se může v modelu objevit i tzv. chyba 
formální . 

Kromě chyb vznikajících při tvorbě výpočtového modelu se musí ještě při interpretaci 
získaných výsledků uvažovat chyby použité metody. O těch se zmíníme později. 

 
Shrnutí pojmů 

 
1. Přímé a nepřímé řešení. 

2. Modelování. 

3. Fyzický, abstraktní a kombinovaný model. 

4. Chyby kvalitativní, složitosti, kvantitativní, konkretizační a formální. 
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Otázky 

 
1. Jaké znáte základní postupy při řešení problémů? 

2. Co znamená pojem modelování? 

3. Definujte pojmy model fyzický, abstraktní a kombinovaný. Do které skupiny patří 
model výpočtový? 

4. Jaké jsou základní kroky při vytváření výpočtového modelu? 
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3 MEOTODY ŘEŠENÍ INŽENÝRSKÝCH PROBLÉM Ů 

 
Čas ke studiu: 1 hodina 

 

 
Cíl: Po prostudování tohoto odstavce budete umět 

  Rozlišit výhody a nevýhody analytického řešení. 

 Rozlišit výhody a nevýhody analytického řešení. 

 Porozumět základním myšlenkám metody konečných prvků. 

 

 
Výklad 

 

3.1 Analytické a numerické řešení 

Konkrétní fyzikální děje lze popsat diferenciálními rovnicemi, případně soustavou 
diferenciálních rovnic, spolu s okrajovými podmínkami, odpovídajícími fyzikální realitě.  
Pro volbu metody řešení existují dvě základní možnosti.  První možností je řešení analytické, 
druhou možností je řešení numerické. 

Při analytickém řešení hledáme výsledek ve tvaru spojitých funkcí. Využívají se 
přitom postupy matematické analýzy, využitím diferenciálního a integrálního počtu. Výhodou 
tohoto, historicky staršího postupu je, že v případě nalezení analytického řešení v uzavřeném 
tvaru máme k dispozici obecnou funkční závislost mezi vstupními veličinami (proměnnými) a 
výstupními veličinami řešeného problému. S takto získaným předpisem pak lze jednoduše 
pracovat a je použitelný pro obdobný typ problémů. Základním problémem však je, že 
nalezení analytického řešení v uzavřeném tvaru je možné pouze pro velmi omezenou škálu 
úloh. Zpravidla se jedná o úlohy s jednoduchou geometrií a při odvození je použito mnoho 
zjednodušení. 

Řešení numerické, je řešení přibližné. Při tomto postupu se převádí problém hledání 
spojitých funkcí na problém hledání konečného počtu neznámých parametrů, pomocí nichž se 
hledané funkce přibližně aproximují.  Tento přechod se označuje jako diskretizace spojitého 
problému. Diskretizovaný problém je řešen algebraickými prostředky v konečném počtu 
kroků. Bez použití výpočetní techniky je tento proces velice obtížně zvládnutelný. Numerické 
řešení je v zásadě dostupné pro každou matematicky popsanou úlohu, jakékoliv geometrie a 
jakkoliv komplikovanou. Při praktických aplikacích je však složitost úlohy omezena 
kapacitou dostupného hardware a časovými nároky na výpočet. Výsledky numerického řešení 
se vztahují jen ke konkrétní úloze. Jakékoliv úpravy a optimalizace vyžadují opakování 
celého procesu tvorby a řešení modelu. 

Existuje mnoho metod pro numerické řešení. V současné době je v technické praxi 
jednoznačně nejpoužívanější pro řešení inženýrských úloh metoda konečných prvků (MKP). 
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Tato numerická metoda má největší výhodu ve své univerzálnosti. Dostupné výpočtové 
konečnoprvkové programy jsou již velmi robustními softwarovými balíky. Před příchodem 
MKP se v hojné míře používala tzv. metoda sítí. Další v současné době využívanou metodou, 
ale ne tak jako MKP, je metoda hraničních prvků (MHP). Budoucností by mohly být 
například tzv. bezsíťové metody (Mesh Free Method). Numerické metody se bouřlivě 
rozvíjejí a jen čas ukáže, které postupy jsou nejvýhodnější pro řešení konkrétních typů úloh. 

3.2 Metoda konečných prvků 

Jak již bylo zmíněno v úvodu, bude se v tomto textu pracovat pouze problematikou 
lineární pružnosti. Nutno na tomto místě podotknout, že metoda konečných prvků není 
omezena na tuto problematiku, ale lze jí využít i při řešení velké škály fyzikálních problémů. 

Lineární teorie pružnosti, která je základem lineárního řešení, vychází z předpokladu 
malých posuvů, malých přetvoření a z platnosti Hookeova zákona. Pod pojmem posuvy se 
zde i v následujícím textu myslí tzv. zobecněné posuvy, tedy posuvy nebo natočení. Malé 
posuvy jsou takové, že těleso po zatížení nezmění znatelně svou polohu. Zobecněné posuvy 
jsou vzhledem k rozměrům tělesa tak malé, že podmínky rovnováhy mohou být psány  
pro původní, nedeformovanou konfiguraci a výpočet napětí může být vztažen rovněž  
k původním rozměrům a to se zanedbatelnou chybou. Malá přetvoření znamenají, že rozměry 
každého objemového elementu tělesa se v důsledku zatížení znatelně nemění. Pokud platí 
předchozí věta, lze pro vyjádření vztahů mezi přetvořeními a posuvy použít Cauchyho 
geometrické rovnice. Vztah mezi napětím a přetvořením jsou dány Hookovým zákonem. 
Materiál je tedy předpokládán izotropní a homogenní. 

Řešení obecných prostorových úloh teorie pružnosti je velice obtížné. V mnoha 
případech můžeme úlohu zjednodušit na dvojrozměrnou, popřípadě na jednorozměrnou. 
Tímto dosáhneme značného zjednodušení popisu a řešení úlohy. Typicky můžeme 
zjednodušit úlohu pružnosti tělesa na: 

1. · jednodimenzionální úlohu, 

2. · dvojdimenzionální úlohu, 

– rovinná deformace, 

– rovinná napjatost, 

– zobecněná rovinná napjatost, 

– axisymetrická úloha. 

3. Do oblasti zjednodušení spadá i zjednodušení úloh spadající do oblastí  

– nosníků, 

– a skořepin. 

V případě metody konečných prvků, je z pohledu algoritmu, jedno v jaké dimenzi se 
nacházíme. Často je však výhodné i při aplikaci metody konečných prvků uvažovat tato 
zjednodušení. 
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3.2.1 Základní kroky metody konečných prvků 

Základní myšlenkou metody konečných prvků je rozložení tělesa na menší části - 
elementy, konečné prvky - na kterých je analýza chování poměrně jednoduchá. V deformační 
variantě, která je nejrozšířenější, se vychází z nahrazení posuvů náhradními funkcemi. Tyto 
funkce se berou ve tvaru polynomů prostorových souřadnic. Celý postup metody konečných 
prvků se dá vyjádřit v několika krocích: 

1. Rozdělení řešené oblasti (tělesa, soustavy) na podoblasti, tzv. konečné prvky či 
elementy. 

2. Formulace chování jednotlivých elementů. 
3. Opětovné složení a získání výsledné soustavy rovnic popisujících chování celého 

systému využitím rovnic získaných při analýze elementů. 
4. Aplikace okrajových či počátečních podmínek. 
5. Vlastní řešení systému rovnic. Získání primárních neznámých. V případě deformační 

varianty MKP se jedná o posuvy. 
6. Získání dodatečných (odvozených) výsledků. V případě pružného tělesa se jedná např. 

o přetvoření a napětí, popř. další veličiny. 

Při použití komerčních konečnoprvkových systémů jsou některé kroky metody 
konečných prvků před uživatelem buď to částečně, nebo úplně skryty. První krok, tedy tvorba 
sítě, je často prováděna pomocí automatických generátorů. Kroky 2. a 3. jsou zcela skryty.  

 

Obrázek 3.1 – Geometrický model sestavy 
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Obrázek 3.2 – Možná konečno-prvková reprezentace geometrie sestavy 

O formulaci a chování elementu je možno se dočíst z dokumentace dodávané 
k danému software. Čtvrtý bod, související s aplikací okrajových a počátečních podmínek je 
v plné režii uživatele systému. Proto, aby byl tento krok proveden správně, musí mít uživatel 
potřebné znalosti a zkušenosti v daném oboru, do kterého řešený problém spadá. Krok pátý se 
často omezuje pouze na volbu typu výpočetní metody (přímé, iterační, aj.) a nastavení daného 
postupu. Posledním krokem je krok šestý, který je v rukou uživatele a platí pro něj stejné 
poznámky jako pro bod čtvrtý.  

Zde se nebudeme zabývat odvozením základních postupů a rovnic metody konečných 
prvků, je zde ukázána pouze aplikace pomocí programu Patran a Nastran. Pro hlubší 
pochopení je čtenář odkazován na příslušnou literaturu.  

 
Shrnutí pojmů 

 
1. Analytické řešení. 

2. Numerické řešení. 

3. Metoda konečných prvků. 

4. Lineární teorie pružnosti. 

5. Zjednodušení modelů (dimenzionální). 
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Otázky 

 
1. Jaké jsou výhody a nevýhody analytického řešení? 
2. Jaké jsou výhody a nevýhody numerického řešení? 
3. Definujte základní předpoklady lineární teorie pružnosti. 
4. Naznačte a popište jednotlivá možná dimenzionální zjednodušení 

modelů v případě pružnosti. 
5. Metoda konečných prvků se skládá z několika kroků. Jaké jsou? 
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4 ROZHRANÍ PROGRAMU PATRAN A JEHO SOUBORY 

 
Čas ke studiu: 1 hodina 

 

 
Cíl: Po prostudování tohoto odstavce budete se umět 

  orientovat v základním rozhraní programu Patran. 

 orientovat v základních souborech Patranu. 

 

 
Výklad 

 

Program Patran lze spustit na různých platformách. Zde se zaměříme pouze  
na grafické prostředí spuštěné v operačním systému MS Windows. Na ostatních platformách 
je toto rozhraní a jeho ovládání velmi podobné. 

Obrázek 4.1 - Základní rozhraní programu Patran 
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Program se dá spustit standardními postupy platnými pro operační systém Windows a 
to buď spuštěním přes nabídku start, nebo přes zástupce na ploše. Po spuštění a načtení (nebo 
založení nové) databáze se objeví rozhraní viditelné na Obrázek 4.1. 

Pozn.: Jedná se o „nové“ rozhraní uvolněné do plného používání od verze 2010. 
Ohledně „starého“ rozhraní je čtenář odkázán na dokumentaci dodávanou s produktem, 
popřípadě na zdroje uvedené na http://www.mscsoftware.com. 

Rozhraní Patranu se skládá z následujících částí: hlavní menu (menu bar), aplikační 
menu (ribbon groups menus), panel pro rychlý přístup (quick access tulbar), grafické okno 
(viewport), okno historie (history window), příkazový řádek (command line), aplikační 
formulář (application form) a ikona stavu (status icon).  

Hlavní menu je zobrazeno na Obrázek 4.2. Pomocí tohoto menu je možno přistupovat 
k hlavním funkcím programu. Menu File, slouží k práci se soubory, např. založení nové nebo 
načtení již vytvořené databáze, tisk, importy a exporty modelů, aj. Menu Group je zaměřeno 
na práce s grupami. Grupy jsou zjednodušeně seznamy (pojmenované oblasti) modelu, blíže 
viz níže v textu. Pomocí tohoto menu se dají grupy vytvořit, smazat, editovat, atd. Menu 
Viewport  slouží k nastavení zobrazení grafického okna (barvy, osvětlení, atd.) a nastavení 
pohledů v daném okně. Menu Display je určeno k zobrazení a nastavení vzhledu jednotlivých 
entit jednak geometrického, jednak konečnoprvkového modelu. V menu Preferences jsou 
dostupné funkce pomocí kterých lze ovlivnit chování programu jako je nastavení databáze, 
možností chování myši při práci, aj. Menu Tools umožňuje přístup k pomocníkům jako je 
například MSC.Fatigue určený pro únavovou analýzu, Beam Tool určený k definování 
průřezů, aj. V menu Help je dostupná nápověda k programu. Poslední položkou je položka 
Utilities ve které jsou dostupné další přídavné funkce, které umožňuji efektivněji vytvářet 
model než základní funkce Patranu. 

 

 

Obrázek 4.2 - Hlavní menu 

Aplika ční menu (popř. pruh) slouží k přístupu k funkcím Patranu. Jednotlivé 
záložky (ribbony) už svým názvem napovídají, kterou částí procesu tvorby modelu se 
zabývají. Aplikační menu je zobrazeno na Obrázek 4.3. V této chvíli nemá cenu podrobně 
rozebírat jednotlivé funkce skryté v jednotlivých záložkách, protože jich existuje veliké 
množství. K některým funkcím se dostaneme níže v tomto textu, ostatní je možno dohledat 
v nápovědě.  

Obrázek 4.3 – Aplikační menu 
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Pro často používané funkce je zde panel pro rychlý přístup, který je umístěn  
pod aplikačním menu. Jeho vzhled je možno upravovat a přidávat popř. odebírat jednotlivé 
funkce dle potřeby. Jeden z možných vzhledů je umístěn na obrázku Obrázek 3.1. 

 

 

Obrázek 4.4 – Panel pro rychlý přístup. 

Přepnutím v aplikačním menu a zvolením funkce uživatelem, se změní vzhled 
aplikačního formuláře. Každý formulář vypadá jinak, ale obsahuje obdobné či stejné typy 
prvků, pomocí kterých je možno vykonávat jednotlivé příkazy. Pro ukázku bylo zvoleno okno 
umožňující provést funkci pro generování bodu v určitém místě, viz Obrázek 4.5. 

 

 

Obrázek 4.5 – Ukázka aplikačního formuláře 

V tomto okně se pracuje metodou „shora dolů“. Jednotlivé názvy položek jsou velmi 
intuitivní a ke každé položce je dostupná nápověda přes horkou klávesu F1. Jak je patrno 
jednotlivé okno se skládá jednak z „listboxů“ ve kterých se vybírá správná položka, jednak 
z textových oken do kterých se zadávají vstupní hodnoty. Pro potvrzení funkce se používají 
tlačítka, zde (na obrázku) je pouze jedno tlačítko „Apply“. Do vstupních boxů je možno data 
zadat dvěma způsoby, a to jednak manuálně, nebo grafickou cestou, tzn. pomocí selekce 
myší. Ke vstupu pomocí druhé metody je možno využít selekčního filtru, pomocí kterého je 
možno zadat pouze selekci požadované entity. Tento filtr je umístěný na Obrázek 4.5 vlevo, 
což je defaultní umístění.  



 

 Fakulta strojní, VŠB-TU Ostrava 

20 Rozhraní Programu Patran a jeho soubory 

Při výběru pomocí myši je možno postupovat několika způsoby. Pokud myší 
pohybujeme po grafickém okně, dochází při přechodu přes entitu k zvýraznění této entity 
(např. plocha, objem, atd.). Při kliknutí levým tlačítkem myši na tuto entitu se provede výběr. 
Pokud je nutno vybrat současně více položek je nutno použít funkční tlačítko „shift“ 
na klávesnici. Pro odselekování omylem vybrané entity je možno použít kombinaci „ctrl“ + 
„shift“ + pravé tlačítko myši. Obdobně slouží tlačítka na filtru výběru a to tlačítka „plus“, 
„mínus“. Tlačítko „rovná se“ odpovídá piknutí myší na jednu entitu bez držení funkčních 
kláves. V případě výběru více entit lze využít výběru pomocí boxu a to jednak obdélníkového, 
který se provádí tak, že se zmáčkne levé tlačítko myši a to se drží při táhnutí přes model.  
Při stlačení klávesy „ctrl“ je možno vytvářet výběr pomocí n-úhelníku. Konec výběru se 
zakončí dvojklikem levého tlačítka myši. 

Chování myši a nastavení jednotlivých kláves při výběru se dá upravit v hlavním 
menu v položce „Preferences > Mouse …“ a „Preferences > Picking …“. 

Další položkou grafického rozhraní programu Patran je okno historie. V tomto okně 
se vypisují všechny provedené operace, varování a chyby. Proto je vhodné, aby uživatel 
pracoval s tímto oknem. Pod oknem historie je umístěn příkazový řádek, do kterého lze 
zadávat manuálně příkazy. Okno historie a příkazový řádek je zobrazen na Obrázek 4.6. 

Poslední položkou grafického rozhraní je ikona stavu. V pravém horním rohu je 
umístěna ikon představující glób se symbolem firmy mscsoftware. Ikona může být ve třech 
základních stavech. Pokud se glób netočí, program nevykonává žádnou akci. Pokud glób 
rotuje a jeho podklad je modrý, program vykonává nějakou funkci a je možno tuto operaci 
přerušit příkazem abort. Funkce abort je dostupná pod ikonkou představující dlaň a je 
umístěna na aplikačním pruhu v záložce „Home“ anebo je defaultně přítomná v panelu  
pro rychlý přístup. Poslední stav, který může být indikován ikonou stavu, je nepřerušitelná 
operace. Tento stav je zobrazován rotujícím se glóbem a červeným podkladem. Takový to 
stav nemůže být přerušen abort ikonou, lze ho přerušit na úrovní operačního systému a to 
shozením procesu Patranu. 

 

4.1 Základní soubory v programu Patran 

Výše bylo zmíněno, že položka hlavního menu File, slouží k práci se soubory, např. 
založení nové nebo načtení již vytvořené databáze, tisk, importy a exporty modelů, aj. Zde 
budou stručně popsány základní soubory používané programem Patran. Jedná se o následující 
soubory: 

Obrázek 4.6 – Okno historie a příkazový řádek 
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• Databáze (Database) – je základní soubor. V tomto souboru je vlastně uložen 
celý námi vytvářený model, tj. jednak geometrie, konečnoprvková síť, 
okrajové podmínky, nastavení analýzy, atd. Přípona souboru je „*.db“. Soubor 
databáze je binární soubor. Platí jeden model, jeden databázový soubor. 

• Jouranal File – Tento soubor se váže na jeden model (databázi). V tomto 
souboru jsou zapsány všechny PCL příkazy, které byly použity při vytváření 
modelu v dané databázi. Soubor je doplňován při každé relaci, u které byl 
editován model v dané databázi. PCL je zkratka pro „Programing Command 
Language“, což je vnitřní programovací jazyk programu Patran. Tento soubor 
se dá využít pro vytváření programových sekvencí (maker) nebo  
pro restaurování vlastní databáze. Jedná se o textový soubor a je ho tedy 
možno otevřít v libovolném textovém editoru. Jméno souboru je stejné jako 
jméno databáze a jeho přípona je „*.db.jou“. 

• Session File – Obdoba journal file, ale tento soubor je otevřen při každém 
spuštění Patranu a uzavřen při ukončení programu. Obsahuje tedy informace  
o jednom sezení. V pracovním adresáři se tedy může objevit několik session 
souborů. Soubor je opět textový, tedy je možno ho prohlédnout v libovolném 
textovém editoru. Přípona souboru je „*.ses“ a navíc se může za touto 
příponou objevit číslo, např. „*.ses.01“, daná počtem tohoto typu souboru. 
Kromě automatického záznamu, lze session soubory generovat a přehrávat 
pomocí položky hlavního menu a to „File > Session File. 

 

 
Shrnutí pojmů 

 
1. Hlavní menu (menu bar) 

2. Aplikační menu (ribbon groups menus) 

3. Panel pro rychlý přístup (quick access tulbar) 

4. Grafické okno (viewport) 

5. Okno historie (history window) 

6. Příkazový řádek (command line) 

7. Aplikační formulář (application form) 

8. Ikona stavu (status icon) 

9. Databáze, journal file, session file 
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5 INFORMACE O PROGRAMU NASTRAN 

 
Čas ke studiu: 1 hodina 

 

 
Cíl: Po prostudování tohoto odstavce budete se znát 

  Základní informace o výpočetním systému Nastran. 

 Základní typy souborů pro komunikaci s tímto řešičem, tj. vstupní a 
výstupní soubory. 

 Komunikaci mezi programy Nastran a Patran. 

 

 
Výklad 

 

Program Nastran je konečnoprvkový řešič (NAsa STRuctural ANalysis Systém). Je 
dostupný pod mnoha operačními systémy a může být spuštěn na osobním počítači i  
na velkých superpočítačích. Program jako takový se skládá z množství modulů, kde každý 
modul odpovídá za určitou specifickou operaci (aplikace okrajových podmínek, generování 
matic, vlastní řešení, atd.). Jednotlivé moduly jsou kontrolovány pomocí vnitřního jazyka 
DMAP (Direct Matrix Abstraction Program).  

Program obsahuje veliké množství analýz. Každý typ analýzy je označen jako 
sekvence řešení (solution sequence) a má svoje kódové číslo. Statická lineární analýza je 
například sekvence 101. 

Program Nastran neposkytuje žádné grafické rozhraní, neposkytuje žádné funkce  
pro grafickou tvorbu modelu. Všechny vstupy a výstupy programu jsou zprostředkovány 
pomocí textových souborů. Základní typy souborů jsou: 

• Vstupní soubor (Input File) – obsahuje definici modelu. Jedná se o textový 
soubor a může mít libovolnou koncovku, nejčastěji „*.bdf“ a „*.dat“.  

• Výsledkový soubor (Result File) – Toto je hlavní Nastranovský výstupní 
soubor. Obsahuje všechny žádané výsledky analýzy, například posuvy, 
přetvoření, napětí, atd. Jedná se o ASCII soubor a je možné ho procházet 
v libovolném textovém editoru. Dále tento soubor obsahuje diagnostické, 
varovné a chybové hlášky, které mohou pomoci při ověřování a ladění modelu. 
Přípona souboru je „*.f06“.  

• Soubor obsahující informace o běhu Nastranu (Execution Summary File).  
Obsahuje časovou historii běhu dané úlohy. Přípona souboru je „*.f04“ a opět 
se jedná o textový soubor. 
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• Log soubor. Obsahuje informace o běhu na daném operačním systému. Přípona 
souboru je „*.log“ a opět se jedná o textový soubor. 

• Výsledkový soubor typu op2. Jedná se o další možný výsledkový soubor, ale 
tento je užíván programem Patran. Jedná se o binární soubor a jeho přípona je 
„*.op2“. 

• Výsledkový soubor typu xdb. Jedná se o další možný výsledkový soubor, ale 
tento je užíván programem Patran. Jedná se o binární soubor a jeho přípona je 
„*.xdb“. V současnosti využíván častěji než soubor typu op2. 

• Další soubory jsou generovány při běhu programu a lze o nich najít informace 
v nápovědě dodávané s instalací programu. 

Protože program neposkytuje žádné grafické rozhraní pro tvorbu modelu ani  
pro vizualizaci výsledků existuje mnoho programů, které umožňují tvorbu popřípadě import 
geometrie modelu, generování sítě konečných prvků, zadávání okrajových podmínek, 
vykreslování výsledků atd. Jedním z takovýchto systému je právě program Patran. Příklad 
spolupráce programů Patran a Nastran je zobrazen na obrázku Obrázek 5.1.  
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Obrázek 5.1 – Nastran a Patran  základní vztah 

 
Další zdroje 

Detailnější informace lze nalézt v dokumentaci dodávané s daným software, popř.  
na internetových stránkách http://www.mscsoftware.com. Pro lineární analýzy pružných těles 
je vhodným dokumentem „Linear Static User’s Guide“ dodávaný s instalací produktu. 
Dokumenty pojednávající o funkcionalitě programu jesou: „Guick Reference Guide“a 
„Getting Started User’s Guide“. 

 
Shrnutí pojmů 

 

1. Vstupní soubor (Input File) –  přípona souboru nejčastěji „*.bdf“ a „*.dat“.  

2. Výsledkový soubor (Result File) – přípona „*.f06“.  
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3. Soubor obsahující informace o běhu Nastranu (Execution Summary File). 
Přípona souboru je „*.f04“. 

4. Log soubor. Přípona „*.log“. 

5. Výsledkový soubor typu „*.op2“. 

6. Výsledkový soubor typu „*.xdb“.  
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6 PŘÍKLAD ZÁKLADNÍHO POUŽITÍ PATRANU A NASTRANU 

 
Čas ke studiu: 2 hodiny 

 

 
Cíl: Po prostudování tohoto odstavce budete se umět 

  Spustit program Patran a vytvořit novou databázi pro tvorbu modelu. 

 Importovat geometrický model z externího souboru. 

 Vytvořit konečnoprvkový model dané součásti včetně zadání okrajových 
podmínek. 

 Provést nastavení programu Nastran z rozhraní Patranu a provést vlastní 
výpočet. 

 Načíst a analyzovat získané výsledky. 

 

 
Výklad 

V následujícím příkladě budou provedeny typické kroky při vytváření 
končnoprvkového modelu. Model se většinou generuje na základě geometrie, která je 
vytvořena v  CAD systému. Výměna geometrie mezi tímto systémem a Patranem probíhá  
přes nějaký výměnný formát, nejčastěji parasolid, iges, sat, aj. V našem příkladě 
neimportujeme model smykového snímače a na tomto modelu provedeme analýzu. Uchycení 
modelu je znázorněno na obrázku Obrázek 6.1. Materiál snímače je ocel s parametry: modul 
pružnosti v tahu E = 210 GPa a poissonovo číslo µ = 0,3. 

Obrázek 6.1 – Okrajové podmínky modelu 
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6.1 Založení nové databáze v programu Patran 

Prvním krokem je spuštění programu Patran a vytvoření nové databáze. Vytvoření 
databáze se provede pomocí příkazu z hlavního menu „File > New …“ . Po stlačení se objeví 
na obrazovce standardní dialogové okno, pomocí kterého se vybere umístění a název souboru. 
V tomto případě je volen název souboru databáze snimac. Pozn.: V názvech adresářů a 
názvech souborů je lepší nepoužívat diakritiku, tj. čárky, háčky a zbytečné mezery.  

V aplikačním okně je nutno nastavit položky Tolerance na Default (1.). Nastavení 
výpočetního programu je defaultně Nastran, takže stačí potvrdit tlačítkem OK (2.). Nastavení 
databáze je znázorněno na Obrázek 6.2. 

 

Obrázek 6.2 – Nastavení nově vytvářené databáze 

6.2 Import externího geometrického modelu 

Dalším krokem je import souboru obsahujícího geometrický model snímače. Import se 
provádí pomocí menu „File > Import …“ . Otevře se dialogové okno, viz Chyba! Nenalezen 
zdroj odkazů.. V okně provést kontrolu, že chceme importovat model ve formátu parasolid, 
tj. položka (1.) na obrázku. Dále pak zmáčknout tlačítko „Parasolid xmd Options …“ (2.). 
V aplikačním formuláři se objeví parametry importu pro zvolený typ souboru, viz Obrázek 
6.4. V novém okně kliknout na tlačítko „Model Units“  (1.), objeví se nová záložka. Zde 
vybrat, že chceme pracovat v milimetrech (2.), potvrdit tlačítkem „OK“  (3.) a po návratu do 
předchozí záložky potvrdit tlačítkem „OK“  (4.). Ve stále otevřeném okně pro výběr souboru 
vybrat soubor s názvem „smykovy_slomerny_snimac.xmt_txt“ a potvrdit tlačítkem „-
Apply-„ .  
Na obrazovce se objeví nové okno, ve kterém jsou shrnuty informace o importu. Toto okno 
zavřeme tlačítkem „OK“ . Tímto je celý proces importu ukončen. 
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Obrázek 6.3 - Dialogové okno při importu součásti 

 

 

Obrázek 6.4 – Nastavení importu modelu 
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6.3 Definice materiálů a vlastností 

Dále se pokračuje ve směru „zleva doprava“ v jednotlivých záložkách aplikačního 
panelu. Záložku geometrie je možno přeskočit, protože nebudou prováděny žádné úpravy 
geometrie. Následující záložka nese název „Properties“ . Pod touto záložkou se skrývají 
funkce, pomocí kterých je možno nadefinovat vlastnosti materiálu a vlastnosti chování 
modelu (elementů). Materiál se zadá jednoduše stlačením tlačítka „Isotropic“  v aplikačním 
menu (1.) a v aplikačním formuláři se objeví okno pro zadání dat, viz Obrázek 6.5.  

V položce „Material Name“  zadejme název „ocel“ (2.). Stlačením tlačítka „Imput 
Properties …“ (3.) se otevře nové okno, pomocí něhož zadáme hodnoty modulu pružnosti a 
Poissonova čísla (4.). Hodnoty se potvrdí tlačítkem „OK“  (5.) současně se uzavře okno a 
v aplikačním formuláři se vše potvrdí tlačítkem „Apply“  (6.).  Materiál se přesune do okna 
nazvaného „Existing Materials“ . Pozn.: Program Patran nehlídá jednotky. Za číselné 
vyjádření zodpovídá uživatel. Jediné jednotky, se kterými se pracuje, jsou u importu, aby se 
model načetl v požadovaných rozměrech. 

 

Obrázek 6.5 – Definice materiálu 

Aby se mohlo k součásti (elementům) správně přiřadit chování, musí se vytvořit tzv. 
properties. Ty se nacházejí ve stejné záložce jako materiál, pouze kousek dál vpravo. Model je 
vytvořen jako prostorový a proto se musí vytvořit tzv. „3D Properties“ . První část tvorby 
vlastnosti je znázorněna na Obrázek 6.6. Do okna „Property Set Name“ se zadá název, zde 
„telo_snimace“ (1.). Po zmáčknutí tlačítka „Input Properties …“  (2.) se otevře nové okno 
s názvem „Input Properties“ . Zmáčknutím ikony (3.) se otevře další okno s názvem „Select 
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Existing Material“ . V tomto okně se vybere, kliknutím na název, materiál „ocel“ . Po 
vyselekování se toto okno automaticky uzavře a v předchozím okně se v položce „Material 
Name“ objeví popisek „m:ocel“ . Okno se uzavře tlačítkem „OK“  (5.).  

 

Obrázek 6.6 – Definování vlastností elementů 

Dalším krokem při vytváření vlastností je selekce místa kde je přiřadit. Postupuje se 
stlačením tlačítka „Select Application Region …“ (6.) Otevře se nová záložka. Pomocí myší 
se vybere tělo snímače, v položce „Selected Members“ se objeví „Solid 1“  (1). Selekce se 
potvrdí tlačítkem „Add“  (2.). Do položky „Application Region“ se přesune potvrzena 
položka. Pomocí tlačítka „OK“  se vše potvrdí a záložka se automaticky uzavře.  

 

Obrázek 6.7 – Selekce oblasti modelu při definování vlastností 
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Nyní je nutno ještě zmáčknout tlačítko „Apply“  aby se vytvořená vlastnost přesunula 
do okna s názvem „Sets By:“, viz Obrázek 6.6. 

Pozn.: Vlastnosti byly zadány na geometrický model. Výpočet však neprobíhá  
na geometrickém nýbrž na konečnoprvkovém modelu. Program Patran při generování 
vstupního souboru řešiče tyto vlastnosti automaticky převede. Někdy je výhodné zadávat 
vlastnosti přímo na uzly či elementy, ale pro tento úkon je třeba nejprve vytvořit síť konečných 
prvků. 

6.4 Okrajové podmínky 

Dalším krokem je vytvoření okrajových podmínek, tj. vytvoření vazeb a zatížení. 
V aplikačním menu se přepne záložka na „Loads/BCs“ . Zmáčkne se tlačítko „Displacement 
Constraint“  a můžou se zadávat data dle následujícího popisu. 

 

Obrázek 6.8 – Zadávání okrajových podmínek na model 
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V prvním kroku se vytvoří pevná vazba (vetknutí) v místech děr pro šrouby. Úkony 
při zadávání se provádí následovně dle Obrázek 6.8. Do položky „New Set Name“ se zadá 
název vazby, zde např „pevna_vazba“ (1.). Stlačí se tlačítko „Input Data …“  (2.). Otevře se 
nová záložka, kde se vyplní položka „Translations <T1 T2 T3>“ . Protože budou vázány 
všechny stupně volnosti, tedy posuvy ve směrech x, y a z, musí se zadat do textového okna 
zápis <0, 0, 0>, (3.). Ten znamená, že jsou zachyceny všechny stupně volnosti. Místo čárek je 
možno použít i mezery. Zápis se vztahuje k souřadnému systému označenému v „Analysis 
Coordinate Frame“, zde „Coord 0“ . Vše se potvrdí tlačítkem „OK“  (4.). Záložka se uzavře, 
pokračuje se tlačítkem „Select Application Region …“ (5.). Otevře se nová záložka, viz 
Obrázek 6.9. 

 

Obrázek 6.9 – Selekce oblasti zájmu při definování okrajových podmínek 

Provede se selekce oblasti, na kterou se mají zadat okrajové podmínky. Vyselekují se 
otvory (1.). Pro jednodušší selekci je možno zapnout filtr na selekování pouze povrchů (2.). 
Výběr se potvrdí tlačítkem „Add“  (3.). Po jeho stlačení se vybrané položky přesunou do okna 
s názvem „Application Region“ . Záložka se uzavře tlačítkem „OK“  (4.). Vše se potvrdí,  
po návratu do předchozí záložky, tlačítkem „Apply“ . Vytvořená vazba se automaticky 
přesune do okna s názvem „Existing Sets“.  

Obdobným způsobem se vytvoří druhá vazba, tedy místo kde leží snímač na podložce, 
viz Obrázek 6.1. Zde již nebudou kroky rozepisovány podrobně, takže stručně. Zadá se jméno 
vazby, zde: „ulozeni“ . V položce „Translations <T1 T2 T3>“  se zadá <, 0, > což znamená, 
že se odebírají stupně volnosti ve svislém směru. Okrajová podmínka se aplikuje  
na požadovanou plochu. Vše se potvrdí tlačítkem „Apply“ . V okně „Existing Sets“ jsou nyní 
obě dvě definované vazby.  

Obdobným způsobem se zadá zatížení. Pomocí ikony v aplikačním menu se spustí 
funkce „Total Load“ . Kroky zadávání jsou velice podobné jako v případě zadávání vazeb. 
Prvním krokem je zadání názvu zatížení, zde „zatizeni“  (1.). Dále se zmáčkne tlačítko 
„Input Data …“  (2.), otevře se nová záložka. Zde se do položky „Load <F1 F2 F3>“ zadají 
hodnoty <0 -500 0>, viz (3.). Vše se potvrdí tlačítkem „OK“  (4.).  
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Obrázek 6.10 – Zadání zatížení pomocí funkce Total Load 

V předchozí záložce se zmáčkne tlačítko „Select Application Region …“ (5.). Opět 
se otevře nová záložka, viz Obrázek 6.11. Vyselekuje se potřebná plocha (1.), potvrdí se 
tlačítkem „Add“ (2.) a záložka se uzavře pomocí tlačítka „OK“. Vše se opět potvrdí tlačítkem 
„Apply“. Tímto postupem jsou zadány okrajové podmínky na model. V grafickém okně je 
možno si prohlédnout zadané okrajové podmínky. 
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Obrázek 6.11 – výběr místa pro zadání zatížení 

 

Pozn.: Okrajové podmínky byly zadány na geometrický model. Výpočet však 
neprobíhá na geometrickém nýbrž na konečnoprvkovém modelu. Program Patran  
při generování vstupního souboru řešiče tyto okrajové podmínky automaticky převede. Někdy 
je výhodné zadávat okrajové podmínky přímo na uzly či elementy, ale pro tento úkon je třeba 
nejprve vytvořit síť konečných prvků. 

6.5 Tvorba sítě konečných prvků 

Dalším krokem je generování sítě. Pomocí myši se program přepne do položky 
„Meshing“ . Protože se jedná o první model, využijeme zde služeb automatického generátoru 
sítě. Pomocí položky v menu (1.) se přepneme do okna pro vytváření sítě na objemových 
entitách, viz Obrázek 6.12. Pomocí myši se vyselekuje geometrický model (2.). Kvalita 
výsledků závisí na kvalitě sítě. Velikost elementu se dá nastavit v položce „Global Edge 
Length“ , zde se zadá hodnota 15, viz (3.). Další nastavení sítě lze najít pod tlačítkem 
„TetMesh Parameters …“. Vše se potvrdí tlačítkem „Apply“  (4.).  

V grafickém okně si lze prohlédnout vytvořenou síť. O kvalitě sítě, jejich úpravách se 
bude hovořit v pozdějších kapitolách. Pro tuto úlohu vezmeme vytvořenou síť. Tímto krokem 
je tvorba modelu v Patranu hotová a je možno vygenerovat vstupní soubor pro řešič, v tomto 
případě se jedná o soubor pro program Nastran.  
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Obrázek 6.12 - Tvorba sítě konečných prvků na modelu 

6.6 Spuštění programu Nastran, vlastní výpočet 

V aplikačním menu se přepne do záložky „Analysis“ . V aplikačním formuláři se 
nemusí nic vyplňovat (u jednoduché úlohy) a stačí analýzu spustit pouze tlačítkem „Apply“ .  

 

Obrázek 6.13 – Okno programu Nastran při výpočtu. 
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Otevře se okno Nastranu, viz Obrázek 6.13, a proběhne výpočet. Konec výpočtu je 
oznámen zapípáním. Nastran během výpočtu vygeneruje množství souborů. Nejdůležitější je 
výstupní soubor je soubor F06, tj. výstupní soubor. V něm se kromě výsledků můžou objevit 
chybové hlášky. K souboru je možno se dostat buď přímo s adresáře, nebo pomocí akce 
„Monitor“ , objektu „Job“ . Pokud se zde, v souboru F06, nevyskytují žádné chyby (fatal 
error) výpočet proběhl a je možno načíst do programu patran výsledky.  

6.7 Načtení výsledků a jejich analýza 

Pomocí položky „Access Results“ a tlačítka „XDB“  (1.), je možno se dostat 
k výsledkům. Na aplikačním formuláři se zmáčkne tlačítko „Apply“  (2.), viz Obrázek 6.14.  
O průběhu načítání je možno se přesvědčit v okně historie. 

 

Obrázek 6.14 – Načtení výsledku do programu Patran 
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V aplikačním menu se přepne do záložky „Results“ . Nejjednodušší cestou k získání 
výsledků je položka „Quick Plot“ , viz Obrázek 6.15. Vybere se položka „Stress Tensor“ 
v okně „Select Fringe Result“ (1.) a položka „Displacement, Translation“ v okně „Select 
Deformation Results“ (2.).  Vše se potvrdí tlačítkem „Apply“ (3.).  

 

 

Obrázek 6.15 – Získání výsledků přes funkci „Quick Plot“ 
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V grafickém okně je možno si prohlédnout výsledky, viz Obrázek 6.16. Teď je možno 
vyzkoušet i vykreslení dalších průběhů, např. posuvy, aj. Po prohlédnutí výsledků je možno 
program ukončit, např. přes hlavní menu položka „File > Quit“ . 

 

 

Obrázek 6.16 – Výsledné napětí na modelu 
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7 ZÁKLADNÍ KROKY P ŘI TVORBĚ MODELU 

 
Čas ke studiu: 3 hodiny 

 

 
Cíl: Po prostudování tohoto odstavce budete 

  Chápat jednotlivé pojmy z oblasti tvorby geometrie v Patranu. 

 Znát základní stavební kameny geometrického modelu. 

 Vědět jaké nejzákladnější typy prvků je možno využít v programu 
Nastran a jak nadefinovat jejich vlastnosti. 

  Jakým způsobem zadat okrajové podmínky. 

 Informace o možnostech generování sítě konečných prvků a úpravách již 
vytvořené sítě. 

 Jak nastavit vlastnosti řešiče. 

 Zpracování načtených výsledků. 

 

 
Výklad 

 

Patran kombinuje topologické struktury pro definování geometrie. Topologické 
struktury jsou znázorněny na Obrázek 7.1. Všechny topologické entity mohou být vybrány 
pro provedení potřebné operace. 

 

Obrázek 7.1 – Topologické struktury 
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V následující tabulce jsou uvedeny jednotlivé asociace pro různé typy geometrií, viz 
Tabulka 7.1. Čísla v udávané tabulce jsou jen pro ilustraci a nevážou se k žádnému obrázku. 

 Seznam bodů 

0D 

Seznam křivek 

1D 

Seznam ploch 

2D 

Seznam 
objemů 

3D 

Bod (Point) Point 123    

Křivka (Curve) Curve 11.1 

(Vertex) 

Curve 11   

Plocha 
(Surface) 

Surface 25.2.1 

(Vertex) 

Surface 25.2 

(Edge) 

Surface 25  

Objem (Solid) Solid 33.3.2.1 

(Vertex) 

Solid 33.3.2 

(Edge) 

Solid 33.3 

(Face) 

Solid 33 

Tabulka 7.1 – Asociace pro jednotlivé typy geometrií 

7.1 Základní stavební prvky geometrie 

Mezi základní stavební prvky geometrie v Patranu patří: 

1. Bod (Point) 
2. Křivka (Curve) 
3. Plocha (Surface) 
4. Objem (Solid) 

Bod - je „nula“ dimenzionální entita, která reprezentuje místo v prostoru. Při vytváření 
geometrií v Patranu, tj. křivek, ploch a objemů, jsou body tvořeny automaticky. Při vytváření 
vyšších entit není nutné vytvářet nejprve body. Při vytváření sítě se na uzlech dají generovat 
0D prvky (např. osamělé hmoty).   

Křivka – je jednorozměrná entita. Křivka je popsána obecnou vektorovou funkcí 
s jednou parametrickou proměnnou. Tato funkce může být vyjádřena v matematickém tvaru 
následovně: 

��, �, �� = ��	
�, 

kde �, �, � jsou místa v prostoru a 	
 je parametrická proměnná. Křivka má dva body, 
každý na jednom konci. Parametrická proměnná se mění od 0 v bodě P1 (počátek) do hodnoty 
1 v bodu P2. Při vytváření sítě se na křivce generují jednorozměrné prvky (bar). 

Plochy - v programu Patran se rozeznávají dva základní typy ploch. Jedná se  
o jednoduché plochy (simple surface), zobrazují se zeleně a o plochy komplexní (komplex 
surface), které se zobrazují fialově. Rozdíl se projeví pro uživatele v době generování sítě. 
Jednoduchá plocha může být síťována libovolným způsobem, tj. IsoMesh, Paver a Hybrid. 
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Naproti tomu komplexní plocha může být síťována pouze posledními dvěma způsoby. Více  
o vytváření sítě nalezne čtenář v příslušné kapitole. 

Jednoduchá plocha se dá popsat obecnou vektorovou funkcí dvou parametricky 
proměnných 	
, 	�. Popis této plochy může být vyjádřen v matematickém tvaru: 

��, �, �� = ��	
, 	��. 

Jednoduchá plocha může mít pouze 3 nebo 4 hrany. V případě 3 hran se jedná  
o plochu se čtyřmi hranami, kdy jedna je degenerována. Parametrický počátek je v bodě P1 a 
obě parametrické souřadnice se mění od 0 do 1.  

Komplexní plocha (complex surface, nebo také označovaná trimmed surface) je 
zobrazena fialově. Může mít více než čtyři hrany a navíc může mít vnitřní hranice (otvory, 
dutiny, atd.). Při definici této plochy nejsou použity parametrické souřadnice.  

Objem – Obdobně jako v případě ploch existují dva základní typy objemových entit – 
jednoduchý (simple) a komplexní (komplex) objem. Liší se barvou. Jednoduchý objem je 
zobrazen v základním zobrazení modře, komplexní objem bíle. Rozdíl se projeví pro uživatele 
v době generování sítě. Na jednoduchém objemu může být síť vytvořena libovolným 
způsobem, tj. IsoMesh, TetMesh. Můžou být tedy generovány prvky ve tvaru čtyř- pěti- a 
šestistěnů.  Naproti tomu komplexní objem může být síťován pouze metodou TetMesh. Více 
o vytváření sítě nalezne čtenář v příslušné kapitole. 

Jednoduchý objem je definován parametrickou funkcí o třech proměnných 	
, 	�,		�. 
Může mít od 4 do 6 vnějších ploch. Počátek je opět v bodě PA a parametrické souřadnice se 
mohou měnit od 0 do 1. V případě 4 a 5 hraničních ploch jsou 2 nebo 1 plocha degenerovány. 

Komplexní objem může mít libovolný počet hraničních povrchů. V Patranu se 
objevuje pojmenování „boundary representation“ nebo taky B-rep. Komplexní solid může být 
vytvořen v nativním Patranovském formátu nebo může být reprezentován v parasolid 
formátu.  

Kromě výše zmíněných entit lze při modelování použít roviny , vektory a uživatelsky 
definované souřadné systémy.  

7.2 Tvorba geometrie 

Geometrie může být v Patranu konstruována přímo, nebo může být naimportována 
z externího CAD systému a poté upravena. Postup importu byl dostatečně ilustrován 
v předchozím příkladu. Možnosti importu do Patranu jsou rozsáhlé a překračují možnosti 
tohoto kurzu. Pro detailní nastudování je možno použít dokumentaci Patranu. 

Při modelování geometrie existují dva přístupy. Jedním je možnost použití 
standardních funkcí Patranovského modeléru, druhý přístup je použít Parasolid jádro. 
Standardní funkce využívají unikátní kód (knihovny). Jejich vývoj má za sebou dlouhou 
historii. Druhou možností je využití parasolid jádra v Patranu. Nevýhodou tohoto přístupu je 
nutnost mít zakoupenou separátní licenci pro použití této knihovny. Tento druhý přístup je 
zvláště pro „moderního“ uživatele příjemnější. 
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Funkce, určeny pro modelování jsou umístěny v aplikačním menu pod záložkou 
„Geometry“, viz Obrázek 7.2 – Nabídka aplikačního menu při tvorbě Geometrie. 

 

Obrázek 7.2 – Nabídka aplikačního menu při tvorbě Geometrie 

Tato záložka obsahuje jednak funkce pro vytváření výše zmíněných entit, jednak 
funkce pro manipulaci s entitami jako jsou posuvy, zrcadlení, atd. (ikonky v podokně 
„Transform“) jednak funkce pro měření, editaci již hotových entit, verifikaci, mazání atd. 
(ikony v podokně „Geometry action“).  

Je zbytečné zde popisovat jednotlivé funkce, ty jsou dokumentovány v dostupném 
helpu a jejich názvy v aplikačním formuláři jsou dostatečně intuitivní. Zde bude popsán 
obecný postup při práci s aplikačním formulářem při modelování. Postup v aplikačním 
formuláři (nejen při vytváření geometrie) je ve smyslu „shora dolů“, jak ilustruje Obrázek 7.3. 

 

Obrázek 7.3 – Postup při generování geometrických entit 

Prvním krokem je vybrání akce. V případě tvorby geometrie se jedná o položku 
„Create“ , při mazání „Delete“ , atd. (1.). Dalším krokem je výběr objektu, se kterým se bude 
pracovat (2.). Poslední je metoda (3.). Výše zmíněná nastavení ovlivní vzhled dolní části 
panelu (4.). Jsou zde zobrazeny jednak vstupní okna, jednak další zatržítka a tlačítka.  
Na Obrázek 7.3 je zobrazená funkce pro vytvoření bodu v prostoru. Ve většině funkcí je 
dostupná položka automatického vykonání funkce po zadání parametrů („Auto Execute“ ). 
Tato funkce velice pomáhá při modelování nejen geometrie, ale je nutno mít na paměti, že  
při zatržení této funkce se daná operace provede automaticky a není nutno zmáčknout 
potvrzovací tlačítko „Apply“ . Po jeho zmáčknutí by se daná entita vytvořila znovu. 
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7.3 Vlastnosti a materiály 

Pro popsání fyzikálního chování modelu je nutno zadat jednak materiálový model 
chování materiálu, jednak správně nastavit vlastnosti chování jednotlivých elementů. 
Využívají se funkce skryté v záložce „Properties“, viz Obrázek 7.4.  

 

Obrázek 7.4 – Vzhled aplikačního panelu při zadávání materiálů a vlastností 

Pro popis jednotlivých elementů a jejich vlastností je vhodné prostudovat manuál 
dodávaný s řešičem, v našem případě program Nastran. V případě tohoto produktu se jedná  
o dokumentaci v manuálech, které jsou dodaný přímo v instalaci, s názvy „Guick Reference 
Guide“, „Getting Started User’s Guide“ a „Linear Static User’s Guide“. Zde jenom uveďme 
nejzákladnější, často užívané, elementy, viz Tabulka 7.2. Ukázka zadání vlastností  
pro trojrozměrné prvky byla ukázána v úvodním příkladu. Pro delší typy elementů se jedná  
o obdobný postup. 

Kategorie Pružina 1D 

Elementy 

2D 

Elementy 

3D 

Elementy 

Tuhé 
(Rigid) 

Elementy 

Fyzikální 
chování 

Jednoduchá 
pružina 

Tyčový 
nebo 

nosníkový 
element 

Tenká 
deska, 

skořepina, 
membrána 

Trojrozm ěrné 
pružné těleso 

Absolutně 
tuhé tyče 

Jméno  
v 

Nastranu 

CELAS2 CONROD 

CROD 

CBAR 

CQUA4 

CTRIA3 

CHEXA 

CPENTA 

CTETRA 

RBE2 

Vlastnost
i 

Nejsou 
potřebné 

PROD 

PBAR 

PSHELL 

 

PSOLID Nejsou 
potřebné 

Obrázek 

  

 

 

Tabulka 7.2 – Základní typy elementů v programu Nastran 
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7.4 Okrajové podmínky 

V předchozích podkapitolách byly zmíněny základní funkce pro tvorbu geometrie a 
konečnoprvkové reprezentace modelu. Pro unikátní řešení je nutno zadat potřebné okrajové 
podmínky. Vazební (kinematické) okrajové podmínky musí být v případě statické analýzy 
zadány tak, aby nemohlo dojít k posuvu tělesa jako tuhého celku. Pro silové okrajové 
podmínky je k dispozici velká paleta funkcí, např. osamělá síla, tlak, zrychlení, aj. Postup 
zadávání byl uveden v úvodním příkladu. 

 

Obrázek 7.5 – Aplikační pruh a nabídka funkcí pro zadání okrajových podmínek 

Kromě zadání okrajových podmínek je zde možnost vytvořit případy zatížení (zátěžné 
stavy), tzv. „Load Cases“. Jedná se o to, že jeden model může být zatížen více způsoby. 
Např. v prvním případě most může být zatížen jen vlastní váhou vozovky, v druhém případě 
na něj působí zatížení od projíždějícího auto, dále pak povětrnostní vlivy, atd. Z každého 
zatížení je možno vytvořit jeden zátěžný stav a provést potřebné simulace. V případě lineární 
analýzy platí princip superpozice a lze separátní výsledky sčítat. Toto je možno provést  
při zpracování výsledků a analyzovat jednotlivé kombinace bez nutnosti počítání.  

Jak zadávat okrajové podmínky bylo dostatečně ilustrováno v předchozí kapitole. 
Postup při tvorbě dalších typů okrajových podmínek je velmi podobný. 

7.5 Tvorba sítě 

Konečnoprvkový model součásti či systému je matematická reprezentace, která 
reprezentuje součást či systém pomocí malých, jednoduše tvarovaných entit, které jsou 
nazývány konečné prvky. Obecněji o MKP viz úvodní kapitoly. Konečné prvky mohu mít 
různý tvary, podle toho na jakou reprezentaci se mají použít. Základní tvary jsou znázorněny 
na obrázku Obrázek 7.6.  

Kromě tvaru musí být element popsán z pohledu jeho fyzikálního chování. To je 
zadáváno pomocí vlastností („properties“). 

Kromě toho se ještě rozeznávají prvky s lineární či kvadratickou aproximací. 
Zjednodušeně řečeno prvky, které mají pouze uzly v rozích, jsou lineární, prvky které mají 
tzv. meziuzly (uzly umístěné např. uprostřed hrany či plochy) jsou kvadratické.  
Pro prostorový prvek jsou zobrazeny na Obrázek 7.7.  

Konečné prvky se dají vytvářet přímo, tj. manuálně se v nějakém umístění vytvoří 
uzly a mezi tyto uzly se umístí daný prvek. Tento způsob síťování se již moc často nevyužívá, 
spíše se využívá druhý způsob, při kterém se síť nechá automaticky generovat na předem 
připraveném geometrickém modelu. Při síťování se tedy postupuje následnými kroky: 

1. Vytvoří se, nebo se importuje geometrie. Při importu se dále vyčistí nepotřebné části 
(např. malá sražení, otvory, atd., tedy z pohledu výpočtu nepodstatné části). 

2. Zvolí se topologie elementu (např. čtyřstěn, lineární, kvadratický, aj.). 
3. Vybere se typ síťovacího algoritmu („mesher“, např. Paver) 
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4. Nastaví se parametry sítě (např. velikost elementu, pokrytí oblouků, atd.) 
5. Provede se vlastní síťování. Pokud vzniklá síť (na její kvalitě záleží přesnost 

výsledků) nesplňuje podmínky, může se celý proces od bodu 2. opakovat až  
do dosažení požadované hustoty a kvality sítě. 

 

Obrázek 7.6 – Základní tvary elementů v programu Patran (barvy odpovídají 
drátovému zobrazení v programu a základnímu nastavení). 
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Obrázek 7.7 – Lineární vs. kvadratické prvky 

7.5.1 Způsoby generace sítě 

Nutno na tomto místě podotknout, že ač program Patran má poměrně velkou škálu 
postupů a funkcí (převážně pro dvojrozměrné sítě), jak vytvořit potřebnou síť na zvolené 
entitě, tak existují i lepší programy. V programu jsou dostupné následující algoritmy  
pro automatickou tvorbu sítě: 

• IsoMesh, 

• Paver, 

• Hybrid, 

• TetMesh, 

• Sweep. 

Kromě těchto technik existují i následující postupy na generování sítí (převážně 
techniky generace sítě na plochách): 

• Mesh on mesh, 

• Sheet body, 

• Advance surface, atd. 

Jak již bylo zmíněno výše je možno také vytvářet síť přímo, tj. vygenerovat přímo 
uzly a mezi ně umístit příslušné prvky. Pro generování praktických úloh není tento způsob 
příliš vhodný. Naopak někdy je potřeba manuálně upravit polohu uzlů sítě. Pro tento způsob 
úpravy sítě poskytuje Patran dostatek funkcí.  

 IsoMesh 

IsoMesh (pro tvorbu mapované sítě) – 1D, 2D, 3D sítě. Vhodný pro síťování všech 
parametrických entit, tj. křivek (žlutá), jednoduchých ploch (zelená) a objemů (modrá). 
Jestliže je geometrie neparametrická nelze tento algoritmus použít.  
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Obrázek 7.8 – IsoMesh na parametrické ploše (jednoduché, zelené). Byly použity 
prvky s topologií QUAD a TRI 

 

 

Obrázek 7.9 – IsoMesh na jednoduchém objemu (modrý). Je možno použít prvky 
s topologií TET, WEDGE a HEX 

Pokud není základní geometrie parametrická (tedy jednoduchá plocha nebo 
jednoduchý objem) je nutno tuto geometrii upravit pro použití IsoMesh způsobu síťování. 
Možná úprava pro dvojrozměrnou úlohu je vidět na následujícím obrázku. Obdobně lze 
postupovat v případě prostorových úloh. 
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Obrázek 7.10 – Použití techniky IsoMesh pro neparametrickou plochu 

 Paver 

Slouží pouze generování sítě na plochách, nelze použít pro generování objemových prvků. 
Je použitelný na jakoukoliv plochu tedy jak na jednoduchou (zelenou), tak na komplexní 
(fialovou). Algoritmus začíná při vytváření sítě na hranách a směřuje směrem do středu 
plochy. 

 

Obrázek 7.11 – Použití techniky Paver a ovlivnění pomocí nastavení hustoty dělení 
(Mesh Seed) a použitím asociované geometrie.  

 Hybrid 

Stejně jako předchozí postup, lze hybridní síťař použít pouze pro generování sítě  
na plochách a to jak rovinných tak prostorových. Síť je vytvářená obdobně jako u Paver 
algoritmus, ale většinou vytváří lépe strukturovanou síť. Nutno konkrétně vyzkoušet.  
Při použití hybridního algoritmu není možno použít asociovanou geometrii (obdobně 
nelze využít u IsoMesh techniky). Asociovaná geometrie je ignorována.  
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Obrázek 7.12 – Porovnání technik Paver, Hybrid a IsoMesh. Byla volena stejná 
velikost elemntů. Při IsoMesh technice musela být plocha rozdělena na parametrické plochy 

(viz výše). 

 TetMesh 

Využívá se pro automatickou generaci objemových prvků. Použitelný na jakýkoliv typ 
objemu (bílý, modrý). Generuje síť tvořenou čtyřstěny (tetraedry). Využívá se tzv. 
Delauney algoritmus. Vytváření sítě je v následujících krocích: nejprve se vytvoří síť 
 na povrchu (pomocí hybridního postupu, viz výše) a pak se generují z takovýchto prvků 
prvky do prostoru (objemu). Jedná se o robustní a rychlý algoritmus. Ukázka této techniky 
byla ilustrována v úvodním příkladu při řešení napjatosti smykového snímače, viz výše. 

 Sweep mesh  

Použitelný pro 2D a 3D sítě. Jedná se o metodu vytahování entit. Z jednorozměrné entity 
při vytahování vzniká entita dvourozměrná, z dvourozměrné entity pak entita 
trojrozměrná. Pomocí tohoto postupu se dají vytvářet velmi dobré sítě. Existuje několik 
možnosti vytahování (ve směru normály, rotace, podél křivky, atd.). Při vytahování nejsou 
vzniklé elementy asociovány s geometrií. Pokud se zadávají okrajové podmínky, popř. 
vlastnosti na solid entity, je nutno provést dodatečnou asociaci prvků s geometrií. 
Asociace se provádí pomocí příkazu „Associate“. Potřebuje-li se oddělit síť od geometrie 
je toho možno dosáhnout funkcí „Disassociate“.  
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Obrázek 7.13 – Síť vytvořená pomocí TetMesh a pomocí Sweep techniky 

Pro pokrytí stejné oblasti pomocí TET prvků (čtyřstěnů) se potřebuje mnohem více 
prvků než v případě pokrytí řešené oblasti prvky ve tvaru HEX (krychle), popř. WEDGE 
(klíny). Při vytváření sítě se dává přednost HEX prvkům (krychličky) před prvky tvaru 
WEDGE (klíny). Obdobně se dává přednost prvkům WEDGE (klíny) před prvky TET 
(čtyřstěny). Co se týče volby, jestli se jedná o lineární nebo kvadratické prvky, je jasno u TET 
prvků, ty se využívají ve variantě s meziuzly, protože lineární varianta nedává dobré 
výsledky. Naproti tomu výsledky s prvky HEX jsou dostatečně přesné v obou dvou 
variantách. U lineárních prvků je však obvykle potřeba větší hustota sítě na stejně velkou 
oblast. 
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Výše byly zmíněny i další techniky Mesh on mesh, Sheet body, Advance surface, atd. 
Tyto techniky slouží ke generování dvojrozměrných prvků. Zmíníme se zde i o technice Mesh 
on mesh. Při této technice se vygeneruje libovolná síť a po té se vezme za základ  
pro vygenerování nové sítě. Takto vytvořená síť již není vázána na původní plochy a může se 
dosáhnout velmi dobrých výsledků. Ukázka tohoto přístupu je zobrazena na následujícím 
obrázku. Opět, pokud to je potřeba se dá vytvořená síť asociovat s původními plochami,  
na kterých byla vygenerována původní síť. 

 

Obrázek 7.14 – Ukázka techniky Mesh on mesh 

Přístup k funkcím pro vytváření a editaci sítě jsou skryty v aplikačním menu v záložce 
„Meshing“ , viz Obrázek 7.15.  

 

Obrázek 7.15 – Nabídka funkcí pro vytváření sítě 

7.6 Nastavení řešiče, vlastní řešení, datový soubor 

K nastavení řešiče a k jeho spuštění se přistupuje přes záložku „Analysis“ . V případě, 
že pro výpočty je zvolený produkt Nastran, je aplikační formulář znázorněn na obrázku 
Obrázek 7.16. Při postupu shora formulář obsahuje následné prvky.  

Dostupné úlohy (Available Jobs) – v tomto okně jsou dostupné již předem 
definované úlohy. V databázi může být více úloh. 

Jméno úlohy (Job Name) – slouží k vytvoření jména pro novou úlohu, ve které 
budou uložena jednotlivá nastavení. 

Další tři položky, tj. Title, Subtitle, Label, jsou nepovinné a slouží k vytvoření 
poznámek k dané úloze.  
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Obrázek 7.16 – Aplikační formulář pro nastavení řešiče Nastran 

 

Tlačítko „Translation parameters …“  otevře nové okno, ve kterém jsou nastavení 
určená pro generování kódu pro příslušný řešič. 

Tlačítko „Solution Type …“  otevře novou záložku, viz Obrázek 7.17, ve které je 
možno vybrat z typu analýzy (1.). V případě lineární statické analýzy se nechá zaškrtnuté 
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defaultní nastavení. Jedná se o sekvenci SOL101. Při výpočtech složitějších a větších úloh je 
výhodné upravit možnost zápisu výsledku do souboru F06. Zmáčknutím tlačítka „Result 
Output Format …“  (2.) se otevře nové okno (3.) ve kterém je dobré odznačit položku 
„Print“ . V tomto případě se nebudou požadované výsledky tisknout do souboru F06 ale 
pouze ukládat do databáze „XDB“ . Všechny okna je pak nutno zavřít tlačítkem „OK“ . 

 

Obrázek 7.17 – Nastavení typu analýzy 

Další tlačítko na základním panelu (Obrázek 7.16) je tlačítko „Direct Text Imput 
…“ , které je určené pro přímé ovlivnění textového vstupního souboru Nastranu.  

Tlačítko „Select Superelements …“ je určeno pro konfiguraci tzv. superelementů. 

Důležité je následné tlačítko s názvem „Subcases …“. Při stlačení tlačítka se otevře 
nové okno, ve kterém se na základě zátěžných stavů, viz okrajové podmínky výše, dají 
definovat tzv. subceses, tedy nastavení jednotlivých zátěžných stavů.  

Dalším důležitým je tlačítko s názvem „Output Requests …“ (1.), viz Obrázek 7.18. 
Po jeho stlačení se otevře nové okno, ve kterém se dají zadat typy výsledků, které mají být 
ukládány do výsledkové databáze (2.). Okno se uzavře tlačítkem „OK“  (3.). Na předchozím 
panelu se musí vše potvrdit tlačítkem „Apply“  (4.). Okno se pak může uzavřít tlačítkem 
„OK“  (5.).  



 

 Fakulta strojní, VŠB-TU Ostrava 

54 Základní kroky při tvorbě modelu 

Tlačítko „Subcase Select …“, viz Obrázek 7.16, je určeno k výběrům jednotlivých 
„Subcase“ definovaných v předchozím kroku. Je výhodné do jedné úlohy umístit všechny 
zátěžné případy a nerozhazovat je do jednotlivých úloh (job). V případě vytvoření více úloh 
dochází v každém výpočtu k novému sestavování výpočtového modelu, což prodlužuje čas 
výpočtu. V případě umístění všech zatížení do jedné úlohy se pouze mění zátěžný vektor a 
z toho důvodu je řešeni rychlejší. 

 

Obrázek 7.18 – Definice a nastavení zátěžných kroků 

Poslední tlačítko je tlačítko „Apply“ . Po jeho stisku dojde k vytvoření vstupního 
souboru pro Nastran a po jeho vytvoření k spuštění výpočtu. Během a po výpočtu je vhodné 
zkontrolovat, jak daná úloha proběhla. Dá se to provést způsobem popsaným v úvodním 
příkladu (Action: Monitor, Object: Job, zobrazit soubor F06). Pokud byla úloha vypočtena, je 
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nutno „natáhnout“ získané výsledky zpět do Patranu. Postupuje se postupem v ukázkovém 
příkladu, viz předchozí kapitola. 

7.7 Výsledky 

Posledním krokem, a tím nejdůležitějším, je zobrazení výsledků a jejich zhodnocení. 
K výsledkům se lze dostat přes záložku „Results“ v aplikačním menu, viz Obrázek 7.19. 

 

Obrázek 7.19 – Aplikační pruh a nabídky pro práci s výsledky 

V tomto menu je nepřeberné množství funkcí pro získání a zobrazení výsledků. 
Nejjednodušší je využití funkce „Quick Plot“ , která byla dokumentována v ukázkovém 
příkladu. Dalšími položkami menu „Results“  jsou nabídky pro vykreslení deformací, hodnot 
ve formě barevných map, vektorů tenzorů, kontur, tvorba grafů z načtených hodnot, 
generování reportů, možnosti výpočtů s vypočtených dat, atd. 

 
Shrnutí pojmů 

 

1. Základní stavební prvky geometrie: bod, křivka, plocha a objem. 

2. Jednoduchá (parametrická) a komplexní plocha. První je v základním drátovém 
zobrazení modelu zelená, druhá je fialová. 

3. Jednoduchý (parametrický) a komplexní objem. První typ objemu je 
v základním drátovém zobrazení modrý, druhý bílý. 

4. Základní tvary elementů – bar, tri, quad, tet, wedge a hex. Lineární a 
kvadratická formulace. 

5. Manuální a automatická tvorba sítě. 

6. Techniky IsoMesh, Paver, Hybrid, TetMesh a Sweep. Technika Mesh on mesh. 

7. Funkce Quick Plot. 
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8 TÁHLO 

 
Čas ke studiu: 3 hodiny 

 

 
Cíl: Po prostudování tohoto odstavce budete umět: 

  Vytvořit geometrii modelu 

 Provést import a export součásti 

 Editovat a mazat části modelu 

 Vytvořit síť několika způsoby 

 Zadat složitější okrajové podmínky 

 Provést výpočet a vyhodnotit výsledky 

 

 
Výklad 

Protože uživatel je již obeznámen s prostředím programu Patran nebude výklad 
probíhat tak detailně jako v případě předchozího příkladu.  

 

Obrázek 8.1 – Základní geometrie modelu 
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8.1 Tvorba geometrie 

8.1.1 Založení nové databáze a nastavení jejich parametrů 

• Spustit program Patran, založit novou databázi.  

• Při založení nastavit preferenci na řešič Nastran a velikost zvolit dle velikosti modelu 
na hodnotu 150.  

• Po založení databáze spustit z hlavního menu položku „Preferences > Geometry … > 
Geometry Scale Factor“ nastavit na milimetry. Potvrdit tlačítkem „Apply“ . 

8.1.2 Tvorba geometrického modelu 

• Přepnout se do záložky „Geometry“ na aplikačním panelu.  

• Nebude-li řečeno jinak, budou funkce označovány v pořadí Action > Object > 
Method, plus příslušná nastavení. 

• Create > Surface > XYZ. Do položky „Vector Coordintes List“ zadat „<100 40 0>“. 
Potvrdit tlačítkem „Apply“. V grafickém okně by se měl objevit zelený obdélník, 
pokud je zapnuto drátové zobrazení.  

 

Obrázek 8.2 – Tvorba geometrie, krok 1 

• Edit > Surface > Add Fillet. Zadat 20 do položky „Fillet Radius“. Zapnout položku 
„Auto Execute“. Vybrat vytvořenou plochu, její název se objeví v položce „Surface to 
Fillet“. Boxem vybrat pravý horní roh plochy. V položce „Vertex List“ se objeví 
příslušný název a funkce zaoblí vybraný roh. 

 

Obrázek 8.3 - – Tvorba geometrie, krok 2 
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• Pomocí tlačítka „Point Size“ v záložce „Home“ na hlavním panelu zvizualizovat 
body.  Vybrat funkci „Transform > Point > Translate“ . Zadat vektor „<0 -20 0>“ 
do položky „Direction Vector“. Pomocí myši vybrat pravý bod na horní hraně (místo 
kde hrana přechází v oblouk“. Ten se přesune na pozici pro střed otvoru. 

•  Použitím funkce „Edit > Surface > Add Hole“ . Položka „Option“ musí být zapnuta 
na hodnotě „Center Point“. Zadat rádius v položce „Hole Radius“, zadat 10. Zapnout 
funkci „Auto Execute“. Vybrat plochu aby se zobrazila v položce „Surface“ a vybrat 
v předchozím bodu vytvořený bod do „Center Point List“. Vznikne otvor  
na požadovaném místě. 

 

Obrázek 8.4 – Tvorba geometrie, krok 3 

• Na aplikačním panelu v záložce „Home“ zapnout zobrazení „Iso 1 View“. Aplikovat 
funkci „Create > Solid > Extrude“. „Translation Vector“ nastavit na hodnotu  
„<0, 0, 10>“. Vybrat plochu do položky „Surface List“. Vygeneruje se objem. 

 

Obrázek 8.5 - – Tvorba geometrie, krok 4 

• Pomocí funkce „Delete > Surface“ smazat základní plochu z které byl generován 
objem. Pomocí „Edit > Solid > Edge Blenad“ provést sražení hran. Vybrat pravou 
ikonku, do položky „Offset“ zadat hodnotu 1. V položce „Edgeds to Blend“ vybrat 
první ikonu a vybrat příslušné hrany.  
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Obrázek 8.6 - – Tvorba geometrie, krok 5 

• Zrcadlení objemu. Využijeme funkci „Transform > Solid > Mirror“ . Definujme 
zrcadlící rovinu do položky „Define Mirror Plane Normal“ zadat hodnotu „Coord 
0.2“ buď manuálně, nebo pomocí selekčního filtru a selekce základního souřadného 
systému v okně geometrie. Vybrat objem a funkce se provede. 
 

 

Obrázek 8.7 – Tvorba geometrie, krok 6 

• Sečteme vzniklé objemy a to přes funkci „Edit > Solid > Boolean“. Zapnout první 
tlačítko pro součet. Do okna „Solid List“ vybrat oba objemy a potvrdit tlačítkem „-
Apply-“. Tímto je dokončeno modelováni objemu. 
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Obrázek 8.8 – Tvorba geometrie, krok 7 

 

• Z cvičného důvodu je možno vyzkoušet export modelu do externího souboru např. 
v parasolid, iges, apod. Provede se to pomocí funkce z hlavního menu pomocí „File > 
Export …“ . Po stlačení tlačítka se objeví dialogové okno podobné tomu při importu 
a je možno provést příslušná nastavení a uložit soubor ve zvoleném formátu. 

8.2 Tvorba konečno-prvkového modelu 

Na začátku je nutno upozornit, že by šlo při modelování využít zjednodušení na úlohu 
dvojrozměrnou (rovinná napjatost), my však z cvičných důvodů provedeme analýzu  
na trojrozměrném tělese. Dále by šlo využít symetrie. Tyto postupy budou určeny  
pro samostatnou činnost.  

8.2.1 Zjednodušení geometrického modelu 

Na modelu se vyskytují zbytečné zkosy. Z pohledu výpočtu jsou zcela bezvýznamné a 
zbytečně by vznikaly v těchto místech malé elementy. Protože jsme vytvářeli daný model, 
vůbec jsme je nemuseli vytvářet. Protože se však jedná o cvičnou úlohu, jejímž úkolem je 
seznámení se s funkcionalitou Patranu, byl vytvořen celý geometrický model. Dále je možno 
si ukázat pomocníka na odstraňování nepotřebných částí geometrie. Tento pomocník se 
nachází v položce hlavního menu „Tools > Modeling > Featrure Recognition …“. Otevře 
se aplikační formulář ve kterém se vybere do položky „Solid List“ objem a poté se klikne 
pomocí pravého tlačítka myši na položku stromu „Featur Tree“ a z plovoucího menu se 
vybere položka „Recognize – Automatic.“ Po rozbalení stromu se objeví nalezené otvory, 
sražení a zaoblení. Pomocí myši se vyberou jednotlivé položky pro zrušení a pravým 
tlačítkem se zruší pomocí položky „Delete“. V grafickém okně by měly zmizet všechna 
sražení. 

Tento pomocník se také dá využit k editaci, např. zvětšení či zmenšení rádiusu děr, 
úpravě zaoblení, apod. 
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8.2.2 Tvorba sítě pomocí automatického generátoru sítě, metoda TetMesh 

• Zapnout funkci pro tvorbu sítě konečných prvků. Přepnout se do záložky „Meshing“ 
na aplikačním panelu. Použije se funkce „Create > Mesh > Solid“. Topologii 
elementu zapnout na Tet10. 

 

Obrázek 8.9 – Tvorba sítě, krok 1 

• Vyzkoušet nastavení pod položkou „TetMesh Parameter“.  V daném okně nastavit 
parametr „Maximum h/L“ na polovinu, tj. 0.05 a parametr „Minimum Edge Length“ 
také na polovinu, tj. 0.1. Potvrdit tlačítkem „OK“ a provést opět síťování s velikostí 
elementu 12. 

 

Obrázek 8.10 – Tvorba sítě, krok 1 

• Z předchozích obrázků jsou patrné rozdíly ve vytvořené síti hlavně v místech otvorů.  
Vyzkoušet si různá nastavení daných parametrů. Po vyzkoušení různých nastavení 
smazat síť konečných prvků příkazem „Delete >Mesh > Solid“. 
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• Další krok je vyzkoušet metodu „Sweep“ a metodu „Mesh on mesh“. Prvním krokem 
při vytahování sítě je vytvoření (v případě vytahování prostorové sítě) elementů  
na jedné ploše. Může se využít libovolná metoda na tvorbu sítě na povrchu. Přepnout 
se na funkci „Create > Mesh > Surface“. Vybrat položku „Elem Shape“ na „Quad“, 
„Mesher“ na „Paver“ a dále „Topology“ na „Quad4“. Vybrat jednu plochu solidu, ta 
co je nejblíže, nastavit položku „Value“ na polovinu defaultně určené hodnoty, tj. 
přepsat na 6. Provést síťování.  

• Vytvořenou síť jde pomocí funkce „Modify > Mesh > Surface“ vyhladit. 

• Vrátit se do položky „Create > Mesh > Surface“ a vyzkoušet nastavení s parametry 
pod tlačítkem „Paver/Hybrid Parameters …“. Položku „Max h/L“ na polovinu, tj. 
0.05. Následující obrázky ukazují obě možnosti.  

 

Obrázek 8.11 – Tvorba sítě, krok 3 

 

Obrázek 8.12 – Tvorba sítě, krok 4 
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• Obdobně vyzkoušet i jiná nastavení. Vše vyzkoušet i pro Hybridní síťař. 

• Přepnout „Create > Mesh > On Mesh“. Zapnout položku „Delete Elements“ a 
„Iso Mesh“. Zmáčknout tlačítko „Mesh Parameters …“ a zapnout nastavení 
„Curvurature Check“ a „Washers around Holes“. Nechat defaultní nastavení. 
Potvrdit tlačítkem „OK“. Vybrat všechny elementy a nastavit položku „Global 
Edge Length“ na hodnotu 5. Potvrdit tlačítkm „-Apply-“.  

 

Obrázek 8.13 – Tvorba sítě, krok 5 

• Vyzkoušet i další nastavení, ale v závěru se vrátit do předchozího kroku a 
vygenerovat síť z předchozího kroku. 

• Vlastní vytahování. „Sweep > Element > Extrude“. Stlačit tlačítko „Mesh 
Control …“ a zapnout „Element Length (L)“ a nastavit hodnotu „Length“  

na hodnotu 5. Vybrat položku „Direction Vector“ a pomocí selekčního filtru 
„Base and tip points“ vybrat dva uzly na horní hraně. 

 

Obrázek 8.14 – Tvorba sítě, krok 6 
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Takto se nadefinuje vektor pro vytažení. Zapnout tlačítko „Delete Original Elements“. 
Pomocí boxu vybrat všechny elementy a potvrdit tlačítkem „-Apply-“.  Vznikne síť 
prostorových prvků.  

 

Obrázek 8.15 – Tvorba sítě, krok 7 

• Posledním krokem je asociace vzniklých prvků k základnímu objemu. Provede se 
to funkcí „Associate > Element > Solid“.  Před použitím funkce je nutno nastavit 
globální toleranci na hodnotu např. 1. Ke konstantě tolerance se lze dostat  
přes položku hlavního menu „Preferences > Global …“ a nastavit políčko 
„Global Model Tolerance“. Po provedení asociační operace lze vrátit hodnotu  
na původní. 

• Tímto krokem je dokončena tvorba sítě. 

8.3 Zadání parametrů materiálů a nadefinování vlastností elementů 

8.3.1 Zadání materiálu 

Materiál budeme uvažovat homogenní a izotropní s elastickými konstantami: modul 
pružnosti 210 GPa a Poissonovo číslo 0,3. Materiál se zadá, tak jak bylo uvedeno 
v ukázkovém příkladu. 

8.3.2 Zadání vlastností 

Stejně jako pro předchozí bod. Využijte znalosti z ukázkového příkladu. 

8.4 Okrajové podmínky 

Dalším krokem je zadání okrajových podmínek. Budeme předpokládat zatížení a 
vazby dle následujícího obrázku. 
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Obrázek 8.16 – Okrajové podmínky, schéma 

V levé části budeme předpokládat, že je součást uchycena bez možnosti jakéhokoliv 
pohybu (např. přivařena) a tím pádem můžeme předpokládat ideální vetknutí. To znamená, že 
musíme odebrat všechny stupně volnosti. U prostorových prvků jsou v každém uzlu tři stupně 
volnosti, pohyby ve směru os x, y a z.  

V pravém horním otvoru budeme přepokládat působení zátěžné síly. V otvoru 
přepokládejme čep o stejné velikosti jako je otvor díry. V tomto případě je vhodné aplikovat 
na asi polovinu otvoru tlak než aplikovat osamělou sílu. Je nutno přepočítat aplikovanou sílu  
na tlak, tj. působící sílu vydělíme kolmým průmětem plochy čepu do roviny síly. Výsledná 
hodnota tlaku je tak 30 MPa. Kromě toho, že aplikujeme tlak na plochu, ještě tento zátěžný 
tlak rozložíme tak, aby největší tlak byl v ose působící síly a pozvolna klesal. Podlé jaké 
funkce, ale tento tlak klesá, je otázka. Osvědčilo se využít rozložení podle funkce sinus popř. 
kosinus.  

Volba okrajových podmínek může velmi „rozhodit“ výpočet a to až tak, že sice 
získáme nějaké výsledky, ale ty nebudou odpovídat realitě. Proto je nutno před každou 
aplikací okrajových podmínek správně pochopit funkci analyzované součásti. 

Při aplikaci okrajových podmínek je v programu Patran možno tyto zadat buď  
na geometrický, nebo na konečno-prvkový model. Při aplikaci kinematické okrajové 
podmínky (vetknutí) využijeme první možnost, tj. budeme aplikovat okrajové podmínky  
na geometrický model. V případě aplikace silové okrajové podmínky využijeme druhou 
možnost a aplikujeme rozložení tlaku přímo na konečno-prvkový model. 

8.4.1 Zadání kinematických okrajových podmínek (vazby) 

• V aplikačním menu se přepnout do záložky „Loads/BCs“. 
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• Vybrat funkci „Create > Displacement > Nodal“. Do okna s názvem „New Set 
Name“ zadat název, např. fix.  

o Stlačením tlačítka „Input Data …“ se přepnout do další záložky a v položce 
„Translation <T1 T2 T3>“ zadat hodnoty <0 0 0>. Tento předpis znamená, 
že byly odebrány všechny stupně volnosti. Vše se vztahuje k souřadnému 
systému Coord 0. Potvrdit tlačítkem „OK“. 

o Po stlačení tlačítka „Select Application Region“ se objeví nový formulář a 
pomocí myši, popř. s použitím filtru vybrat požadovanou oblast na kterou 
bude předepsaná okrajová podmínka aplikována. Přidat vyselekovanou 
plochu, pomocí tlačítka „Add“ do okna „Application Region“. Po té 
potvrdit tlačítkem „OK“. Po zmáčknutí tlačítka bude uzavřena aktuální 
záložka a v aplikačním formuláři se objeví předchozí okno. 

 

Obrázek 8.17 – Aplikace okrajových podmínek, krok 1 

o Potvrdit tlačítkem „-Apply-“. Název okrajové podmínky (zde fix) bude 
přesunuto do „knihovny“ definovaných okrajových podmínek zobrazených 
v okně „Existing Sets“. 

8.4.2 Vytvoření pole pro definici rozložení tlaku 

 Definice uživatelského souřadného systému 

• V aplikačním menu se přepnout do záložky „Geometry“. 

• Pomocí funkce „Create > Point > ArcCenter“  vygenerovat v místě horního 
otvoru pomocný bod, do kterého bude umístěn souřadný systém. 
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Obrázek 8.18 – Aplikace okrajových podmínek, krok 2  

 

• Vybrat funkci „Create > Coord > Euler“ . Přepnout „Type:“ na hodnotu 
„Cylindrical“. V okně „Origin“ vybrat vygenerovaný bod. V okně se automaticky 
vytvoří požadovaný souřadný systém (pokud je zapnuta funkce „Auto Execut“, 
pokud ne potvrdit tlačítkem „-Apply-“). Že se jedná o cylindrický souřadný systém 
lze poznat dle popisku os T, R a Z. 

 

Obrázek 8.19  – Aplikace okrajových podmínek, krok 3 
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 Tvorba prostorového pole pro rozložení tlaku 

• V aplikačním menu kliknout na ikonu s názvem „Create Spatial function“ 
v položce „LBC Fields“.  

• V aplikačním formuláři nyní je možno definovat funkci „Create > Spatial > PCL 
Function“ . Do položky „Field Name“ zadat název, např. rozlozeni_tlaku. „Field 
Type“ zapnout na „Scalar“. Vybrat do položky „Coordinate Systém“ vytvořený 
souřadný systém Coord 1. Do položky „Scalar Function“ zadat hodnotu cosr(`T). 
Proměnou `T je nutno vybrat z okna „Independent Variables“. Vše potvrdit 
tlačítkem „-Apply-“.  

• Provést kontrolu definované funkce. Přepnout se do funkce „Show“ v daném 
aplikačním formuláři. Vybrat v knihovně „Select Field To Show“ definovanou 
funkci, tj. rozlozeni_tlaku. Zmáčknout tlačítko „Specity Range …“. Otevře se 
nové okno a v položce „Maximum“ zadat hodnotu 6.28 (tj. 360° v radiánech) a 
v položce „No. of Points“ zadat hodnotu 20. Potvrdit tlačítkem „OK“. Stlačit 
tlačítko „Apply“. Otevřou se dvě nová okna, jedno je graf zobrazující danou 
funkci a druhé je tabulka s hodnotami. Zkontrolovat správnost. Tabulku zavřít 
tlačítkem „Cancel“. Zmačknout tlačítka „Delete All Curves“ a „Unpost Current 
XY Window. 

 Zadání tlaku 

• Zapnout funkci „Create > Pressur > Element Uniform“. V položce „New Set 
Name“ zadat název okrajové podmínky, zde např. tlak. „Target Element Type“ 
přepnout na hodnotu „3D“.  

o Zmáčknout tlačítko „Input Data …“. Otevře se nová záložka. Vybrat myší 
položku „Pressure“ a poté kliknout na námi definované pole v okně 
„Spatial Fields“. V položce „Pressure“ se objeví f:rozlozeni_tlaku. 
V položce „Load/BC Set Scale Factor“ zadat hodnotu 30. Potvrdit 
tlačítkem „OK“. 

  

Obrázek 8.20 – Aplikace okrajových podmínek, krok 4 
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o Kliknout na tlačítko „Select Applicatio Region …“. Zadat „Select:“  
na hodnotu „FEM“. V selekčním filtru vybrat položku „Free face of 
element“. V hlavním menu vybrat položku „Preferences > Picking …“ a 
v otevřeném panelu vybrat položku „Rectangle/Polygon Picking“ a nastavit 
ji na hodnotu „Enclose entire entity“. Zavřít tlačítkem „Cancel“. Pomoci 
myši a selekcí pomocí boxu vybrat požadované hrany elementů. Stlačit 
„Add“, potvrdit „OK“. Výb ěr viz Obrázek 8.21. 

o Vše potvrdit tlačítkem „-Apply-“. V grafické okně se zvizualizuje zadaný 
tlak.  

 

Obrázek 8.21 – Aplikace okrajových podmínek, krok 5 

 

Předchozími kroky byly zadány okrajové podmínky pro řešenou úlohu. Těmito kroky 
bylo dokončeno vytváření konečno-prvkového modelu a je možno přejít k vlastní analýze.  

8.5 Vlastní řešení a zobrazení výsledků 

8.5.1 Vlastní analýza, načtení výsledků 

Dalším krokem je nastavení řešiče. Provede se kroky popsanými v příslušné kapitole, 
tj. kapitola 7.6  

• V aplikačním menu se přepnout do položky „Analysis“.  

• V položce „Solution Type …“ vypnout tisknutí výsledků do souboru f06, postup 
viz kapitola 7.6.  

• V položce „Subcases …“ vybrat „Grid Point Force Balance“ pro zápis hodnot  
do výsledkového souboru, postup je opět zobrazen v kapitola 7.6.  

• Spustit analýzu pomocí tlačítka „Apply“.  

• Provést kontrolu na chyby v souboru f06. 
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• Načíst výsledky do programu Patran, viz ukázkový příklad kapitola 6.7. 

8.5.2 Zobrazení výsledků 

• V aplikačním menu se přepnout do položky „Results“.  

• Použít funkci „Quick Plot“. V položce „Select Result Case“ vybrat danou položku. 
Vybrat vykreslovanou hodnotu v okně„ Select Fringe Result“ nyní „Displacent, 
Translational“. V okně „Select Deforamtion Results“ vybrat „Displacement, 
Translational“. Potvrdit tlačítkem „Apply“. V grafickém okně se zvizualizují 
požadované hodnoty. 

 

 

Obrázek 8.22 – Posuvy [mm] 

 

• Z předchozího obrázku je možno usoudit, že model se chová reálně dle 
předpokladů na jeho chování. 

• Použít funkci „Quick Plot“. V položce „Select Result Case“ vybrat danou položku. 
Vybrat vykreslovanou hodnotu v okně„ Select Fringe Result“ nyní „Stress 
Tensor“. V okně „Select Deforamtion Results“ vybrat „Displacement, 
Translational“. Potvrdit tlačítkem „Apply“. V grafickém okně se zvizualizují 
požadované hodnoty. Maximální hodnota napětí dle hypotézy HMH je 58,6 MPa. 
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Obrázek 8.23 – Napětí dle HMH [MPa] 

 

Obrázek 8.24 – Napětí dle HMH [MPa], detail 
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• Takto by bylo možno pokračovat v dalších analýzách výsledků a vyvodit závěry. 
Pro posouzení kvality výsledků by bylo vhodné v místech s největší koncentrací 
provést zahuštění sítě (alespoň dvojnásobně) a provést přepočítaní výsledků. 
Pokud by se moc nelišily, mohly by být brány jako věrohodné. Zahuštění lze 
provést manuálně, nebo automaticky (viz nápověda dodávaná s programem 
Nastran). 

• Posledním krokem je uložení databáze a ukončení programu. 
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9 ZÁVĚR 

Předložený text se zabývá základní práci s programy Patran a Nastran od firmy MSC 
Software. Tato práce se zaměřuje pouze na základní poznatky, aby byl uživatel schopen 
rychle začít pracovat s danými produkty, a určitě si neklade za cíl projít všechny dostupné 
funkce a možnosti. K tomu slouží dokumentace dodávané s danými software, popřípadě 
tematicky zaměřené školení.  

Současně je v úvodu textu zpracována problematika modelování a velice stručný 
nástin metody konečných prvků, tak aby uživatel nepřistupoval k problematice řešení 
lineárních úloh statiky jako k „černé skříňce“. 

Pokud se podařilo dosáhnout cíle, tj. uvést uživatele do „tajů“ daného software a 
pochopení základních principů modelování, je autor spokojen. 

 

 


